
 

 

 

 

 

Navigating CTO Stream (REB Users) 

 

 

CTO Helpdesk: 

support.ctontario.ca 

 

 

 

  

https://support.ctontario.ca/


 

CTO Stream REB User Guide:   Page 2 of 21 
Navigating CTO Stream (REB Users) 
V4.0 

 

Contents 

1) Finding an Application ........................................................................................................................................... 3 

2) Viewing Applications – Submission Timeline Page .................................................................................................. 4 

2.1 Timeline Tab (Submission Timeline) ..................................................................................................................... 5 

2.2 Project Tab (Submission Timeline) ....................................................................................................................... 6 

2.3 Documents Tab (Submission Timeline) ................................................................................................................ 7 

2.4 Contacts Tab (Submission Timeline) ..................................................................................................................... 9 

2.5 Correspondence Tab (Submission Timeline) ...................................................................................................... 10 

3) Project Overview Page ......................................................................................................................................... 11 

3.1 Submissions Tab ................................................................................................................................................. 12 

3.2 Tree Tab .............................................................................................................................................................. 13 

3.3 Documents Tab (Project Overview) .................................................................................................................... 13 

3.4 Data Tab .............................................................................................................................................................. 14 

3.5 Approved Contacts Tab ...................................................................................................................................... 15 

3.6 Correspondence Tab (Project Overview) ............................................................................................................ 15 

3.7 Centres Tab ......................................................................................................................................................... 16 

3.8 History Tab (Project Overview) ........................................................................................................................... 16 

4) Actions Menu ...................................................................................................................................................... 17 

4.1 Form Submissions ............................................................................................................................................... 17 

4.2 Project Submissions ............................................................................................................................................ 18 

5) The Application Form ........................................................................................................................................... 18 

5.1 Viewing an Application ....................................................................................................................................... 18 

5.2 Accessing Documents from Within an Application Form ................................................................................... 19 

5.3 Viewing Changes on Re-submission ................................................................................................................... 20 

 

 

 

 



 

CTO Stream REB User Guide:   Page 3 of 21 
Navigating CTO Stream (REB Users) 
V4.0 

1) Finding an Application 

When applications are submitted to a research ethics board in CTO Stream, reviewers can access the submissions 

from the Review Tiles (Figure 1) of their Work Area. The review tiles are logically named according to the status and 

type of applications contained within. For example, the “REB Submissions” tile holds all new CTO Stream submissions 

that are waiting to be processed, while the ‘For My Review’ tile contains submissions that you have been assigned to 

review. The tiles that are visible in your Work Area depends on the role you have with the REB. More information 

about the Tile System can be found in the Getting Started user manual, available on the CTO website.  

 
 

 
Figure 1 

To view the applications contained within a specific review tile, click anywhere on that tile. A table will appear on 

the page with each displayed as a row of the table (Figure 2). Information about each application is shown in the 

table columns (columns vary based on tile). You can export the records in the table via four different formats (file 

downloaded to a folder specified in user’s browser settings): 

• Copy – Copies all rows of data in the table to the user’s clipboard, which can then be pasted to another 
document 

• Excel – Export records to .xlsx to format (Microsoft Excel) 

• CSV – Exports records to .CSV format 

• PDF – Exports records to .PDF format 

 
Figure 2 

Various formats available to export tile data 

The number on the front of the tile shows how 

many applications are contained within. 

The name of the Review Tiles and Tile Groups 

correspond to the type of review selected 

and the status of the submissions within 

https://www.ctontario.ca/cto-programs/streamlined-research-ethics-review/webinars-and-training/reb-user-guides-and-quick-guides/
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Table 1 – Review Tile Information (REB Submissions Tile) 

Column Name Description 

Application Type 
The type of application being reviewed (i.e., Centre Amendment, Provincial Amendment, 
etc.) 

Review Reference The unique system-assigned identifier for a submission version of an application 

Project ID A unique four-digit unique identifier to each project in CTO Stream 

Short Study Title 
The short title of the project provided by the research team (this is not the official study 
title) 

Review Status The current status of the application within the REB review process (REB workflow) 

Review Date 
Received 

The date the application was submitted by the applicant 

Assigned Reviewer 
Full Name 

Lists any reviewers and/or REB staff assigned to the application 

2) Viewing Applications – Submission Timeline Page 

To open a submission from a review tile, click on any data field from that row of the table (i.e., Project ID, Review 

Reference, etc.) (or any field) in that row of the table. Clicking on a submission form from within a Review tile will take 

you to the Submission Timeline page of the application form (Figure 3). This page acts like a “cover page” for the 

submission and contains general information such as project ID, study title, type of application, etc. All the information 

displayed for a submission is summarized below in Table 2. 

  
Figure 3 

Table 2 – Submission Timeline Page 

Column Name Description 

Current 
Committee 

The name of the REB of Record for the study 

Application 
Type 

The type of application being reviewed (i.e., Centre Amendment, Provincial Amendment, etc.) 

Clock Status The elapsed time (in days) since the application was submitted 

Conflicted Users 
The names of the REB members/staff for which a conflict has been registered (more 
information on registering conflicts can be found in The Review Process manual) 
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Applicant Name 
Name of current project owner (user who created the study in CTO Stream), not the lead 
applicant 

Current Status The current status of the form within the REB review process (REB workflow) 

Meeting The name of the full board meeting to which the application has been assigned (if applicable) 

Assigned 
Reviewers 

The names of the assigned reviewers or REB staff and their corresponding reviewer assignment 

 

2.1  Timeline Tab (Submission Timeline)  
Scrolling down the Submissions Timeline page you will notice five tabs which each have a unique function. The leftmost 

tab is called the Timeline tab (Figure 4) and is open by default when a reviewer opens a submission. The other four tabs 

(from left to right) are:  

• Project  • Documents • Contacts • Correspondence 

The function of each tab is described in detail over the next few sections. 

 
Figure 4 

Tip: Zoom in or out using the buttons in the top left corner of the diagram in Figure 4, or by placing the mouse cursor 

over the diagram and using the scroll wheel. 

The Timeline tab displays REB actions that other reviewers (or CTO Admins) have previously performed on the 

submission. It also includes a timeline diagram which gives a visual representation of the progress of the application 

through the review process, up to the current point in time. Below the diagram is a list of each action in chronological 

order. The blue boxes in Figure 4 (above) represent REB actions which progress applications from one step of the REB 

workflow to the next.  

The Timeline Tab shows previous 

steps or actions for the submission 
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Figure 5.1 

 
Some actions generate an email to notify the applicant of the 

progress of their submission and some actions have an 

associated letter. For example, the ‘Send Approval Letter - 

PIA’ action allows the REB to edit the approval letter before 

it is sent to the research team and notifies them of the 

approval by email (notification depends on role) as well. To 

view the email or letter sent for an action, click the paperclip 

or email icon visible in the row for that action (Figure 5.1). 

Click in the row of an action in the list to view the “Event 

Information” for that action which includes the REB user who 

performed the action as well as any Timeline Notes made by 

the user (Figure 5.2). Tip: An Asterix (*) is shown after the 

name of any action in the list that has an associated 

Timeline Note. 

 
Figure 5.2 

2.2  Project Tab (Submission Timeline) 
The Project tab shows all the applications that submitted for a project so far arranged in a ‘Project Tree’. The various 

applications are represented by the “branches” of the tree (rectangular boxes) with a label (or Form Reference) to 

identify the form (Figure 6). The form reference includes an abbreviation for the application type (i.e., PIA, CIA, etc.) 

and additional information such as the month and year the application was submitted.  

The study title is displayed at the top of the project tree and provides a link to the Project Overview page (described in 

Section 3). Directly below the study title is the first submission for the study which is always the Provincial Initial 

Application (PIA). As additional forms are submitted for the project, they are slotted into the tree in alphabetical order. 

Centre post-approval submissions are added to the project tree in alphabetical order, branching off their parent Centre 

Initial Application (CIA)). Clicking on a form in the tree takes you to the Submission Timeline Page for the application. 

 

Click the envelope icon to view the email sent with the action 

Click the paper clip icon to view the document attached to this action (i.e., REB Approval Letter) 
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Figure 6 

2.3  Documents Tab (Submission Timeline) 
In the Documents tab there are two lists of documents. The list at the top is called Form Documents and the list below 

it contains the Review Documents (Figure 7). 

 
Figure 7 

a) Form Documents 
Form documents are documents uploaded to the application by the study team. Information displayed in the table of 

documents is separated into nine columns, described below in Table 3. 

 

 

 

 

Not an application form, but a link to the Project Overview page 
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Table 3 – Documents Tab Information (Submission Timeline) 

Column Name Description 

Type 
The type of document uploaded (determined by the form question the document was uploaded 
to) 

Document Name The name of the document inputted by the applicant at the time of uploading into the form 

File Name 
The name of the file on the applicant’s computer selected when uploading a document into the 
application (cannot be edited by the REB, is not relevant to the actual ethics review) 

Version Date 
The version date of the document as specified by the research team (this is an optional field, and 
usually only completed if there is a version date on the associated document) 

Version The version number of the document as specified by the research team (optional field) 

Size The size of the file being uploaded (KB) 

Document 
Status 

Status of the document as shown in the approval/acknowledgement letter sent by the REB of 
Record 

View The download button allows you to download this document to your computer 

Archived Shows whether the document has been replaced by a more recent version via amendment 

 

b) Review Documents: 
Each submission has a place for reviewers to upload ‘Review Documents’ located under the Documents tab. These are 

optional documents REBs can upload to complete the REB file in CTO Stream (i.e., correspondence or other documents 

relevant to the submission), help facilitate the review (i.e., reviewer checklists). These documents are not visible to the 

study team.  

c) Adding a Review Document: 
To upload a new review document, click the ‘+ New Document’ button to open the Document Upload pop-up window. 

Click ‘Browse’ (Figure 8) then select a file from your computer to upload into the application. Choose a Document Type 

from the drop-down menu and then enter a version date and version number (mandatory). Press the green ‘Upload’ 

button when finished to upload the document. The document will now appear in the list of Review Documents.  

 

 
Figure 8 

Tip: Document Type, Version Date and Version are mandatory  
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d) Removing a Review Document:  
To delete a review document from an application, click on the red ‘Delete’ button (Figure 9) associated with the document 

you wish to delete.  

 
Figure 9 

Tip: Deleting a document immediately and irrevocably deletes the document from the application. There is no second 

validation step for this action. 

 

2.4  Contacts Tab (Submission Timeline) 
The Contacts tab lists all contacts that are associated with an application. There are two types of contacts: Form Contacts 

and Review Contacts. 

 

a) Form Contacts: 
Form Contacts refer to the individuals who were listed in Section 1.0 of the Centre initial application for the site or the 

study-wide Provincial initial application. study team. The Form Contacts tab (Figure 10) will appear empty for Continuing 

Reviews, Reportable Events, and Study Closure submissions because these forms do not contain contact questions*. 

*Form contacts were removed from CTO Stream post-approval applications (except amendments) in CTO Stream on 
Feb 2019.  

Information about each form contact is separated into four columns:  

• Full Name – The full name of the person  

• Email –The person’s email address  

• Organization – The name of the person’s organization  

• Type – The role of the person as listed in the application 

 
Figure 10 

 

Click to delete a review document 
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b) Review Contacts: 
The Review Contacts act as a directory that reviewers can use to store an individual’s contact information. These contacts 

are never visible to any other users.  Tip: The use of review contacts is optional, and contacts saved here do not get 

access to submitted applications for the REB via this feature. The Contacts feature does not provide much benefit to 

REB users beyond storing contact information. 

c) Adding a Review Contact: 
To upload a new review contact, click ‘+ New Review Contact’ from the bottom section of the Contacts tab. This will bring 

up the Add New Contacts pop-up window where the contact information can be inputted.  

 
Figure 11 

a) Removing a Review Contact:  
To delete a review contact from an application, click the red ‘Delete’ button associated with the contact.  

 

2.5  Correspondence Tab (Submission Timeline) 
The Correspondence tab contains a list of all correspondence messages sent back and forth between the study team and 

REB of Record. Each message is displayed as a row of the table, along with information about the message (i.e., the user 

who sent it). This information is described below in Table 4. To open a correspondence message, click anywhere on the 

row containing the desired message. Clicking on the Review Reference number for a submission will take you back to the 

Timeline.  Tip: The list of messages can be sorted by any of the columns by clicking the grey triangles to the right of the 

column header.  

 
Figure 12 

 

 

The Blue text is a hyperlink to the submission 
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Table 4 – Correspondence Tab (Submission Timeline) 

Column Name Description 

Form 
Reference 

The name of the application form (as displayed in the Project Tree) that the correspondence 
message was created on 

User Name of the user who created and sent the correspondence message 

Review 
Reference 

Unique identifier of the specific submission where the correspondence message was created 

Date The date the message was sent 

Message 
Displays the first 40 characters of the correspondence message. Click the message to open the 
complete message in a pop-up window.  

Attachment 
A paper clip icon will appear if a document is attached to the correspondence. The word “none” will 
appear if no document is attached. Click the paper clip icon to open the attachment. 

 

3) Project Overview Page 

The Project Overview page summarizes all of the study information from all submissions into a single place. From this 

page reviewers can access a list of all submissions made for the study and view any documents attached to the 

submissions. To access the Project Overview, click on the study title in blue text at the top of the page (Figure 13) while 

on the Submission Timeline of an application. Tip: Reviewers can also get to the Project Overview page by clicking the 

Project ID (blue box in Figure 13 below). 

 
Figure 13 

The Project Overview Page contains 7 tabs (Figure 14) that are like those on the Submission Timeline however, the tabs 

on the Project Overview contain information and documents from all submissions over the entire duration of the study 

(i.e., they are not submission-specific). 

Click the study title to access 

the Project Overview Page 
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Figure 14 

 

3.1  Submissions Tab 
The Submissions tab lists all forms submitted to the REB for the duration of the study and includes information about 

each submission (see Table 4 below). Like most tabs in CTO Stream, the list is searchable and can be sorted by clicking 

the triangles to the right of each column header. Tip: Use the search bar to filter out applications by status. For example, 

to view a list of only approved REB applications, type the word “approved” in the search bar. 

 
Figure 15 

Table 5 – Submissions tab 

Column Name Description 

Form 
Reference The name of the application form as displayed in the Project Tree 

Form Name The name for the type of application submitted  

Submission 
Date The date the application was submitted in CTO Stream.  

Review 
Reference  Unique system-generated identifier for a specific submission version of an application 

Current Status The current status of the form within the REB review process (REB workflow) 

 

The Submissions tab provides a list of all 

applications associated with the project 
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3.2  Tree Tab  
The Tree tab is akin to the Project tab on the Submission Timeline Page. It also provides a view of the Project Tree, 

showing all submissions for the study with each form represented by a branch of the tree. Clicking on a branch will take 

you to the Timeline Tab of the latest submission of that form (if the form was submitted more than once).  

The forms are visually represented in the tree by rectangular boxes (Figure 16) which includes the application type of 

the form and additional information, depending on the type of application. For example, the Principal Investigator 

surname and organization will appear for a Centre Initial Application (CIA).  

 
Figure 16 

3.3  Documents Tab (Project Overview) 
The Documents tab contains a list of all the documents ever submitted to the REB for the current study. Reviewers can 

download any document from the list by clicking the ‘Download’ button in the row of the desired document. The 

“Archived” column (far-right column in Figure 17) allows reviewers to see which project documents have been archived 

(or replaced) by more recent versions submitted as an amendment. If the Archived checkbox has been ticked off, it means 

the document has been archived. Information about the submitted documents is shown in each columns of the table, 

which are summarized in Table 6 below. 

 
Figure 17 

Click an application form to view 

the Submission Timeline for the 

most recent submission of the form 

Click ‘Download’ to download 

A checkmark will appear here if a document has been replaced by a newer submission 
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Table 6 – Documents Tab (Project Overview) 

Column Name Description 

Form 
Reference 

The name of the application form as displayed in the Project Tree 

Form Name The name for the type of application submitted  

Submission 
Date 

The date the application was submitted in CTO Stream 

 Status The current status of the form the document was uploaded to within the REB review process 

Type The type of document uploaded (determined by the form question the document was uploaded to) 

Document 
Name 

The name of the document inputted by the applicant at the time of uploading into the form 

File Name 
The name of the file on the applicant’s computer selected when uploading a document into the 
application (cannot be edited by the REB, is not relevant to the actual ethics review) 

Version  The version number of the document as specified by the research team (optional field)hy 

Size The size of the file being uploaded (KB) 

View The download button allows you to download this document to your computer 

Category 
The category selected for the document by the reviewer during the Categorize Documents step of 
the workflow 

Archived Shows whether the document has been replaced by a more recent version via amendment 

 

3.4  Data Tab  
The Data tab (Figure 18) of the Project Overview page contains data input by CTO administrators such as the initial 

submission date and the final approval date of the PIA submission for the project in addition to other administrative 

information. The data in this tab is used to facilitate the inclusion of this information in reports, please do not make any 

changes to the data under the Data Tab. 

 
Figure 18 

*Data tab is intended for CTO use only 
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3.5  Approved Contacts Tab 
The Approved Contacts tab is a directory of study personnel for the Provincial (lead) and participating site study teams. 

These are the individuals whose contact information was listed in Section 1.0 – General Information of the Provincial 

Initial Application (PIA) and/or Centre Initial Application (CIA) submissions. Note: Contacts listed on Provincial/Centre 

Amendments are also shown here if the contact has been changed. The primary purpose of the Approved Contacts tab 

is to ensure that the correct Centre Principal Investigator or Provincial Applicant appears in REB letters. 

The “Status” column in the table represents whether the form where the contact is listed has been approved or 

acknowledged by the REB. An “Approved” status is shown for the most recent contacts approved by the REB. Once the 

REB sends the approval/acknowledgement letter for an amendment that includes changes to study personnel, the 

Approved Contacts tab is automatically updated to show the new investigator or other study contact. The status of the 

previous contact will be is updated as well to show “superseded”.  Typically, only changes to the Provincial Applicant 

(and/or Provincial Co-Applicant) or Principal Investigator require REB approval, but REB approval or acknowledgement 

of the application form in CTO Stream is also required for changes to the other study personnel listed in the form. Only 

the “approved” and “pending” contacts appear in the list by default. Use the “Show all contacts” checkbox (Figure 19) to 

show all the “declined” and “superseded” study personnel.  

 
Figure 19 

 

3.6  Correspondence Tab (Project Overview) 
All correspondence messages sent between the REB and study team across all applications for the entire study can be 

viewed from the Correspondence tab of the Project Overview. The “Review Reference” column of the table (Figure 20) 

displays an identifier for specific submission a message was sent on. It can be used as a hyperlink to go directly to the 

Submission Timeline of the submission where the message was created.  

 
Figure 20 

Press to view “Superseded” and “Declined” contacts 

Link to Submission Timeline 
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3.7  Centres Tab 
The centres tab shows the expiry date and status of research ethics approval for the overall project (“Provincial” centre) 

and each centre participating in the study (Figure 21). If required, REB users can edit the Status or Expiry Date for a 

centre by clicking on the Centre Name of that site in the table. For example, if the REB selected the wrong expiry date 

for a study when approving a PIA, they should correct the date here and re-issue the approval letter.  Tip: Studies in 

CTO stream have a single expiry date that is shared by all participating centres. 

 
Figure 21 

 

3.8  History Tab (Project Overview) 
The History tab of the project overview (Figure 22) contains the complete REB history for the study overall. This includes 

an audit log of all actions conducted on the review side of the system for the project, including the date, and form on 

which they were conducted.  Like the other information in the project view, the list is searchable and sortable by clicking 

the arrows to the right of each column name. 

 
Figure 22 



 

CTO Stream REB User Guide:   Page 17 of 21 
Navigating CTO Stream (REB Users) 
V4.0 

4) Actions Menu 

The Actions Menu is located on the left-hand side of the screen and contains various actions that can be performed on 

the application at any given time. The menu is dynamic, meaning that the that appear will change depending on the 

page the reviewer is currently on and the status of the application. As an example, when a reviewer is on the Submission 

Timeline page, the Actions toolbar will look like in Figure 23 below. Some of the actions allow you to perform 

administrative actions such as, making a comment or creating a note to file, and some actions will progress the 

submission to the next step of the workflow, such as ‘Send Review Letter’. 

 
Figure 23 

The Workflow Actions and Administrative Actions are described in The Review Process user manual on the CTO 

webpage), however there are two key navigational buttons available to REB users through the Action toolbar: 

• Form Submissions – Lists all submission versions of the application and allows for easy navigation between 

them.  

• Project Submissions – Will direct user to the Submissions tab 

 

4.1  Form Submissions 
Each time the study team resubmits an application in response to comments/feedback from the REB (or CTO), it is 

considered a ‘new version’ of the application. The ‘Form Submissions’ button (Figure 24) visible in the Actions Menu 

displays the total number of submission versions that exist for the current form (i.e., how many times it has been 

submitted). Using the ‘Form Submissions’ button allows REB users to easily access previous submissions of an 

application form they are reviewing.  

 
 
 
 
 
 
 
 
 

 
Figure 24 

https://www.ctontario.ca/cto-programs/streamlined-research-ethics-review/webinars-and-training/reb-user-guides-and-quick-guides/
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4.2  Project Submissions 
The Project Submissions button indicates how many application forms have been submitted for the current project. 

Clicking the button will take the user to the Submissions tab of the Project Overview.  

 

5) The Application Form 

While reviewing a submission, you can view any comments made by other reviewers, make new comments of your 

own, and convert the application form to PDF format (where it can be printed).  This section outlines how to review 

the application form, view study documents and complete other tasks outlined above. 

 

5.1  Viewing an Application 
Clicking the ‘Review Application’ button (Figure 25) in the Actions Menu will bring up 

the Table of Contents for the application form which shows all applicable sections of 

that application. Due to the use of dependencies between questions in the application 

forms, some sections and questions numbers may appear to be missing because they 

are not applicable.  

Tip: Review Application button is always available in the Actions Menu, even if the 

application has been sent back to the research team for changes. 

 
 

 
Figure 25 

The screenshot below (Figure 26) shows what the Actions Menu looks like from the Table of Contents page. Each of 

the action buttons are described below in Table 6.  

 
Figure 26 

 

Table 7 – Action Menu (Table of Contents Page) 

Action Name Action Description 

Timeline Directs user back to the Submission Timeline 

View as PDF 
This will open a PDF file of the entire application (excluding the attached documents) which can 
then be saved and/or printed 

Click the question numbers 

of a section to open it.  
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Documents This will bring up a full list of documents that have been attached to the application.  

Panel 
Comments 

This will bring up the list of panel comments added to the application by any REB user.  

Changes 
The number displayed represents the total number of changes made to the application since the 
previous submission of the form  

Form 
Comments 

This will bring up a list of form comments added to the application by any REB user.  

To open a section of the form, click on the question numbers for that section (Figure 26). The buttons showing in the 

Action Menu will change once the user has entered a section of the form. Several of the new actions that appear within 

the application are used to help the user navigate through an application form. Table 7 summarizes the function of 

these actions.  

Table 8 – Action Menu (Inside Application) 

Action Name Description 

Previous Will take the user back to the preceding section of the form (like flipping back one page in a book) 

Next Brings the reviewer to the next section of the form. 

Navigate Takes users back to the Table of Contents page for the application 

 

5.2  Accessing Documents from Within an Application Form 
Documents (e.g., the protocol, Informed Consent Form, etc.) can be accessed from within any section of the 

application by clicking the ‘Documents’ button in the Actions toolbar. This will bring up a list of documents that have 

been uploaded to the application by the research team.  

You can download any form document by using the checkboxes in the far-left column to select the desired documents 

and then clicking ‘Download Selected’ button at the bottom of the pop-up window. You can also view the documents 

in PDF format, instead of downloading them by clicking ‘View Selected’. This opens the selected documents in PDF 

format within a new browser tab.   

 
 

Figure 27 

Click ‘Download All’ to 
download a document of all 
submission documents 
combined into a single .PDF file 
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Tip: Some documents are not able to convert to pdf format (i.e., Microsoft Excel or Word tracked changes) and 

need to be downloaded individually using the ‘Download’ button in the row. Any documents that could not be 

converted will be listed at the end of the pdf document. 

 

5.3   Viewing Changes on Re-submission  
When an application is re-submitted by the study team after the REB has requested changes, the number of changes 

the applicant made to the form (number of questions changed) is represented by a red number on the ‘Changes’ 

button of the Actions Menu. 

Clicking ‘Changes’ opens a pop-up window which lists the question number and title of each question the study 

team changed since the previous submission (Figure 28).  

Tip: Reviewers can determine if the application they are 

looking at is a re-submission by checking the number of 

Form Submissions. If the number is greater than one, the 

application has been submitted multiple times. 

 

Reviewers can click any question title in the list to go directly 

to that question within the application and view the changes 

made to the question from the previous submission of the 

form.  

 
 
 
 
 
 

 
 
 
 
 

 

 

 
Figure 28 

 
Figure 29 

Click ‘View Changes’ to view the changes from the previous submission (as tracked changes). Anything deleted by the 

study team is highlighted in red and any additions are highlighted in green (Figure 30).  

Click ‘View Changes’ to see the changes made from previous submission 
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Figure 30 

 

 


